INSTALLATION
HARDWARE SUPPORT
EXPLORING THE NEW DESKTOP
ACCESSIBILITY AND VOICE RECOGNITION
CONNECTING TO THE NETWORK
BACKUP AND RESTORE
SYSTEM MAINTENANCE AND MANAGEMENT
CUSTOMIZING THE LOOK AND FEEL
WORKING EFFICIENTLY
TROUBLESHOOTING
VIRTUAL WINDOWS XP MODE
Fast Track to Windows 7
CREDITS

The People Behind This Book

EDITORIAL
Editor                     Robert Sovereign-Smith
Head-Copy Desk           Nash David
Writer                    Rahil Banthia

DESIGN AND LAYOUT
Lead Designer             Vijay Padaya
Senior Designer           Baiju NV
Cover Design              Anil T

© 9.9 Mediaworx Pvt. Ltd.
Published by 9.9 Mediaworx
No part of this book may be reproduced, stored in a retrieval system or transmitted in any form
or by any means without the prior written permission of the publisher.

November 2010
Free with Digit. Not to be sold separately. If you have paid separately for this book,
please email the editor at editor@thinkdigit.com along with details of location of
purchase, for appropriate action.
Contents

1 Introduction to Windows 7 ................................................................. 07
2 Installation ...................................................................................... 20
3 Hardware Support ......................................................................... 27
4 Exploring the new desktop ............................................................ 31
5 Accessibility and Voice Recognition ............................................. 47
6 Connecting to the Network ............................................................ 57
7 Backup and Restore ....................................................................... 74
8 Customising the Look and Feel ..................................................... 84
9 Virtual Windows XP Mode ............................................................ 88
10 System Maintenance and Management ........................................ 96
    (on the Playware DVD)
11 Working Efficiently ..................................................................... 124
    (on the Playware DVD)
12 Troubleshooting .......................................................................... 129
    (on the Playware DVD)
Introduction

Windows 7, which was released to manufacturing on July 22, 2009, and reached general retail availability on October 22, 2009, played a major part in driving revenue up for Microsoft. The company generated $62.48 billion in revenue over the 2009-2010 fiscal year, a 7 per cent increase from the year prior, and its highest revenue ever on the books. To put things into perspective, in the nine months since its launch, Microsoft has sold 175 million copies of Windows 7 – about 638,600 copies every day – or in even more stark terms, seven copies every second. Now that’s incredible!

Windows 7 did not introduce a lot of new features and was intended to be a more focused, incremental upgrade to the Windows line, with the goal of being compatible with applications and hardware with which Windows Vista is already compatible. But its reception by the community in general was in stark contrast to Windows Vista’s. In only eight hours after pre-ordering began on Amazon, the orders surpassed the demand Windows Vista had in its first 17 weeks, making it the highest-grossing pre-order in Amazon’s history. It took Windows 7 only two weeks to surpass the market share of Apple’s Mac OS X Snow Leopard operating system. Windows 7 reached a 4 per cent market share in less than three weeks. In comparison, it took Windows Vista seven months to reach the same mark.

All the stats and speculation aside, we bring this Fast Track to Windows 7 to ease you into the operating system, which is most-likely to be bundled with your present laptop/netbook or the next one if you plan to buy in the next couple of years. We hope to cover everything from different ways of installing Windows 7, customising your system to your liking, maintaining it to troubleshooting common problems.

If you still haven’t upgraded to Windows 7, the first three chapters serve as an excellent guide to deciding whether you need this, which
Introduction

version to buy, how to install depending on your system and how to get all your hardware working with the new OS. You can directly skip to chapter 4 if you have an installed and working Windows 7 and are looking to explore its new features and improve your efficiency at getting things done.

Chapter 6 will help you get connected to the internet and other local networks to best exploit them, set up home groups, or even get a media server running. The next two chapters are the most essential when it comes to customising the look and feel in Windows 7 while making sure you don't lose any of your precious data. If you’re someone who wants to run legacy software and are concerned about compatibility Chapter 9 is a good place to start.

Chapters 10 and 11 help you make the most of your time on Windows 7 and help you understand how to maintain the system. Last but not the least, you have a chapter that solves a very important issue - Troubleshooting, which will help you solve the little niggles that you may experience along the way.
All factors considered, Microsoft has the beginnings of a solid, streamlined, higher performing operating system with Windows 7 receiving a warmer reception as compared to Vista. When it comes to look and feel, the new UI of Windows 7 is the biggest step forward since Windows 95. It even makes the vintage-XP design look downright primitive. Under the hood, Windows 7 is a lot like Vista, sharing the same kernel architecture. Many consider Windows 7 to be just a cosmetic upgrade, a more polished version of Vista with little to offer beyond the new wallpaper and improved Aero experience. They couldn’t have been more wrong. Windows 7 brings with it many new and enhanced features and improvements, which taken together deliver improved performance and productivity, better troubleshooting, a richer gaming experience, stronger security, a new approach towards compatibility with Windows XP mode and a whole lot more.

Windows 7 feels quick and responsive. It’s a solid performer even on hardware originally designed for Windows XP, and we’ve found that it uses significantly less memory, disk space, and CPU cycles than Vista. There is a Resource Monitor, which allows you to perform some serious real-time sleuthing into running programs, services, and processes to see which ones are affecting performance or making unexpected network connections.
Windows Vista’s most reviled feature, UAC, has been completely overhauled to be more customisable. Windows 7 also includes integrated support for multitouch displays.

Microsoft had tried to get its "Castle" networking scheme into Windows Vista, but the feature finally appears in Windows 7 as HomeGroup. It is a combination of workgroup networking with easier file and media sharing, making it easier to create a home network where various computers scattered around the household share pictures, music, videos, documents, printers, and other resources with each other. Windows 7 also includes a new infrastructure for enabling more efficient background tasks.

Windows 7 is the first client version of Windows to include the Windows PowerShell version 2, a .NET-based scripting environment for IT professionals, out of the box. It will also include an Integrated Scripting Environment (ISE) for PowerShell. Virtually all end-user functionality in Windows have minor tweaks and improvements.

Ironically, Windows 7 offers better driver coverage than Vista, even on systems that were designed for use with Vista. Missing drivers also typically showed up via Windows Update. The new Devices and Printers folder offers a simplified view of user-managed devices. The accompanying Device Stage interface for managing these devices offers a user-friendly alternative to geeky dialog boxes and navigating your way around in the Device Manager, especially for managing MP3 players, mobile phones, photo frames and...
Windows 7

printers. Windows Vista was all about improving memory management, networking, process management, security, maintaining the compatibility with applications, etc. even though it quite didn't live up to the promise. Windows 7 builds on that foundation and delivers a better experience to users. If you’ve been stuck in a time loop using Windows XP or Windows Vista, which is just plain annoying for most people, you can finally break free. Windows 7 is more than what Vista should have been - it’s where Microsoft needed to go.

1.1 A breakdown of different versions

1.1.1 Windows 7 comes in six separate variants:
- Starter (OEM only)
- Home Basic
- Home Premium
- Professional
- Enterprise
- Ultimate
1.1.1 User Interface
User Interface features are similar in Home Premium, Professional and Ultimate. However, Home Basic lacks the Aero UI with Aero Peek, Aero Shake, and Flip 3D all missing. Live Previews in Windows Explorer is also not available. The Starter Edition offers a very basic UI and apart from what's missing in Home Basic, it lacks Live Taskbar previews also.

1.1.2 Performance
Home Premium, Professional and Ultimate support two physical processors, whereas Home Basic and Starter are limited to single processor support. Physical processors is not equal to multi-core and all variants offer multi-core support.

Also, Home Basic and Starter only come in 32-bit versions resulting in a limitation (below 4 GB) to the maximum RAM supported. 64 bit Home Premium can however support 16 GB and Professional and Ultimate 64 bit offers support for up to a whopping 192 GB of RAM.

1.1.3 Reliability
Ultimate variant has BitLocker, and BitLocker To Go encryption technology which is missing from all others. Also, Professional and Ultimate offer backing up to a network and encryption of the File system which is not there in all Home Variants and the Starter Edition.

1.1.4 Bundled Applications
Home Premium, Professional and Ultimate come with its own Snipping Tool, Sticky notes and Windows Journal. These utilities are missing from Home Basic and the Starter Edition.

1.1.5 Multimedia
Home Basic and Starter variants do not offer Windows Media Center, DVD playback, MPEG-2 decoding and Dolby Digital compatibility like Home Premium, Professional and Ultimate. Home Basic and Starter do not support TV tuners while the other variants can support up to 4 tuners each of analogue and digital TV.

1.1.6 Networking
Home Basic and Starter can only join a HomeGroup and not start HomeGroup sharing whereas other variants can start their own HomeGroup. Starter
Introduction to Windows 7

Windows 7

Edition does not even offer Internet Connection Sharing and bridging of networks, a feature available in all other variants.

Hosting a Remote Desktop connection is only supported on Professional and Ultimate, however, all Home variants can connect via Remote Desktop. Also, Home variants lack the utility to make files available offline.

1.1.7 Mobility

Home Basic and Starter do not offer Tablet-PC functionality and multi-touch support, something that comes by default in Home Premium, Professional and Ultimate. Also, Windows Mobility Center in Home variants (Home Basic and Home Presentation) lacks presentation mode present in Professional and Ultimate.

1.1.8 Enterprise Features

This is one area where Ultimate scores big above all other variants. Several features such as Applocker, Booting from VHD, DirectAccess, Federated Search, Multilingual User Interface Language Packs, BranchCache and a subsystem for UNIX-based applications are only available for Ultimate and if any of these are essential to you, Windows Ultimate is your only choice. Also, Windows XP mode, Location-Aware Printing and the ability to join a domain or company networks are only available in Professional and Ultimate. Home variants miss out on almost all enterprise features, but nothing surprising about that.

1.2 Windows 7 vs. Vista vs. XP

Each new software version brings with it a silent promise that it will be better than the last one and most people switch to it instantly. But Windows Vista changed all that. For whatever reasons, be it the vast difference between Vista and XP, popular reluctance to switch or performance issues with Vista that dragged along, it was very poorly received. As a result, computer manufacturers were forced to sell new systems with XP or at least offer a downgrade option. Even as service pack 1 was released adoption was still less than stellar, especially in enterprises, prompting Microsoft to launch
creative marketing campaigns (And a little Mac-bashing) in an attempt to sway public opinion, none of which seemed to have an effect, except being a topic of discussion and mockery on tech forums.

You are probably wondering what type of improvements Windows 7 would offer over Vista or legacy Windows XP. Is Windows 7 just Vista with a facelift, or has Microsoft learned from its mistakes and delivered a product that Vista should have been from the start that will restore its battered reputation and stop its revenues from plummeting further south?

1.2.1 Performance
Windows 7 performs better than Vista and is also faster than XP, although XP, with its lightweight core remains more capable for devices with limited memory and outdated graphics. Vista is just outright sluggish. Windows 7 is better optimised for multi-core CPUs and includes a number of tweaks to make the best of the latest hardware. It delivers excellent results, beating or coming close to the performance of the lightweight XP in just about every category. Working on light applications comes at par with XP and working with processor and memory intensive applications is a breeze when compared to both Vista and XP.

1.2.2 Memory management and cache usage
With Vista, Microsoft introduced a new technology called SuperFetch for caching applications and speeding up boot times. This feature preloads frequently-used applications into RAM, so they can be accessed quicker when they’re needed.

The SuperFetch feature in Windows 7 differs significantly in approach and cache memory usage from its counterpart in Vista. Under Vista, the caching of applications starts immediately at boot-up. In Windows 7, SuperFetch gets a delayed start and eventually also allocates much lesser RAM to it. This means Windows 7 uses lesser resources without affecting performance and launch time of applications. The cache usage is also lower as compared to Vista.

1.2.3 Networking
Windows Vista had promised optimised TCP/IP, but didn't live up to the hype. There were new features like option to set up ad hoc Wi-Fi networks using the Network Setup wizard, WPA2 encryption, remembering settings for different LAN connections and the Network Map displaying a graphical
Windows 7

Introduction to Windows 7

view of all your network connected devices, but internally it was no major improvement over XP and file transfer speeds were even lesser than XP generally. No amount of user-friendliness can mask the difference in speed. Windows 7 takes Vista’s plethora of features and adds HomeGroups. But that’s not it; the performance difference is noticeable. Transferring large files is significantly faster than even XP. The option of setting up a HomeGroup, which although limited with other Windows 7 machines, make networking simpler and managing a home server easier. Troubleshooting solves most basic problems without requiring any input from your part and you don’t have to call tech support over minor problems like IP conflict and a disabled DHCP.

1.2.4 Security

There are plenty of reasons to like Windows XP, but security isn't one of them. Microsoft still releases patches and security updates for XP and will continue to do it till April 2014, but it still lacks internal security developments present in Vista and enhanced in Windows 7.

Agreed, Windows Vista's UAC is annoying and bugs you with too many notifications, but it ensures that your system is not meddled by third-party software applications. The utility is improved in Windows 7 and allows you to customise it with multiple security levels and choice of getting alerts or disabling them completely.

Windows 7 also comes with BitLocker, an encryption tool which was not there in any previous version of Windows. Unfortunately, this feature only comes with Ultimate edition of Windows, and other editions of Windows 7 and Vista users will be in the same position as XP.

In Windows 7 and Vista, system services are more isolated and run with fewer privileges, reducing the damage that malicious code can do. A new TCP/IP stack offers improved encryption and authentication options, and Address Space Layout Randomization loads system files as random memory addresses, making it far harder for basic malware to exploit key system functions.

Windows 7 borrows Vista’s advances and allows you to customise so it scores above XP and Vista.

Its Windows 7 > Vista > XP in terms of Security.

1.2.5 Gaming

One of Windows USP is its gaming abilities. Even though Vista came out
1 Introduction to Windows 7

long time back, XP remains the choice of platform for most game developers and almost every major release is made to run on it. Vista can handle almost all of them with some requiring you to run in Compatibility mode and some working better than they do on XP. There is no shortage of compatible gaming accessories for both XP and Vista alike.

While Vista added support for DirectX 10 gaming, Windows 7 comes with DirectX 11 - a graphics and sound standard which delivers better image quality, new effects, 3D and improved performance shou your graphics card is Dxt1 compatible. Windows 7 also does not have any performance issues like Vista and utilises RAM better both XP and Vista. If you have a mid range spec-ed computer, Windows 7’s gaming performance will impress you with higher frame rates in general. While it cannot handle older DOS games like XP, we would still go with Windows 7-XP-Vista for gaming because once game developers start utilising Dxt1, games will come alive in full 3D glory on your computer.

1.2.6 Startup and shutdown

Startup Time is not really a factor when you judge the performance of an Operating System because most power users start their computer only once a day. But its an important cosideration for an average user who uses his computer for short intervals spread over different times in the day. He will expect the computer to start as fast as possible. Another consideration is the fact that Start-up and Shut-down times are the first directly measurable indication of OS’s speed.

We tested all the three Operating systems on a laptop with 2.4 GHz (P8400) Centrino 2 processor, 4 GB of RAM at 800 MHz FSB and a 7200 RPM hard-disk drive. Windows 7 took 23 seconds to bring the desktop, whereas XP took 27 seconds and Vista faired a high 34 seconds. Now, there is a difference between appearance of the Desktop and the full start-up of an Operating system since a lot of services in Windows 7 and Vista are scheduled to 'delay-start'. To compare that, we started Windows and measured the time it took to connect to the internet, Open Internet Explorer and open Google.com Homepage. Windows 7 gets to work quickly and after the appearance of the desktop it took only a further 3 seconds to display the Google homepage. Compared to this, Vista took more than 8 seconds and XP took a competitive 4 seconds. The whole startup process for Windows 7 up to the appearance of Google took 26 seconds. Vista takes 42 seconds and XP 31 seconds.
Windows 7

Windows 7 also shuts down quicker than its two predecessors, taking just 6 seconds compared with 9 seconds for Vista and just a bit more than 6 seconds for XP.

Overall, the startup and shutdown timings show that Windows 7 performs best in a clean install. XP comes a close second and Vista a distant third. However, updates, security patches and application installations may alter those timings.

1.3 Vs Linux?

Linux has never been able to set foot in the desktop arena even though for years, we have been saying 'This is the year of Linux'. Windows recently has lost some hold with its share dropping 3% but it still holds its ground at 88%, and that also goes to OS X’s credit.

Fedora and Debian distros like Ubuntu lately have been making waves and some computer manufacturers even give you an option to buy a computer with Linux preinstalled instead of Windows but the major problem with that is: The price difference between a Windows-bundled CP and one that comes with Linux is negligible. So, most buyers tend to go with Windows since they can get a free Linux distro later on and install themselves. This has always been there in Windows vs Linux debates.

But lets look from a feature point of view if Windows 7 can trump Linux. Windows 7 installs easier although one can argue that recent Linux distros come with easy to use installers and some even feature a powerful Disk Manager within. When it comes to easy availability of software (Again arguable), Gaming (Windows kills Linux in this) and simpler configuration of user settings (Agreed that it’s not as customizable as Linux; but it’s simpler), Windows 7 probably appeals more to an Average Joe. Windows 7 brings in new dimensions to the age old debate. We shall not go more into it.

1.4 32-bit vs 64-bit

32-bit Operating systems can only handle about 3-3.5 GB of RAM because of the $2^{32} = 4$ GB limitation. (Unless you are running the specially modded kernel image with Physical Address Extension –PAE mode enabled which you can do by adding /PAE switch to your boot config file or by typing "BCDEdit /set PAE forceenable" in command prompt of Windows 7)

Most recent processors are however 64-bit processors, so it makes more sense to go for a 64-bit Operating System. That even removes the 4GB RAM limitation and in general can be more responsive when running.
multiple tasks together. Home Premium, Professional, Enterprise and Ultimate variants of Windows 7 all come in both 32-bit and 64-bit versions. Even with all its advantages, people still prefer 32-bit Operating Systems because of lack of 64-bit softwares, its inability to run 16-bit programs and a few misconceptions as well. Let’s see if we manage to clear your doubt regarding this.

Is your computer capable of running a 64-bit version of Windows?

To run a 64-bit version of Windows 7 or any other operating system for that matter, your computer must have a 64-bit-capable processor. If you are unsure whether your processor is 64-bit-capable, do the following:

- Open Performance Information and Tools from the Control Panel.
- Click on “View and print detailed performance and system information”.
- In the System section of the window that appears, you can see what type of operating system you’re currently running under System type, and whether or not you can run a 64-bit version of Windows under 64-bit capable heading. (If your computer is already running a 64-bit version of Windows, the 64-bit capable listing might not be available.)

Screen showing if your computer has 32-bit or 64-bit operating system
Windows 7

Introduction to Windows 7

Is your computer currently running a 32-bit or a 64-bit version of Windows? To see if your computer is running 32-bit or 64-bit Windows, do the following:

- Open System from the Control Panel
- There, you can view the system type.

Can you upgrade from a 32-bit version of Windows to a 64-bit version of Windows?

No. If you are currently running a 32-bit version of Windows, you can only upgrade to a 32-bit version of Windows 7. Similarly, if you are running a 64-bit version of Windows, you can only upgrade to 64-bit version of Windows 7. If you want to move from a 32-bit version of Windows to a 64-bit version of Windows 7, you’ll need to perform a clean installation of the 64-bit version of Windows.

Can you run 32-bit programs on a 64-bit computer?

Yes. Most programs designed for a computer with 32-bit Windows will work on 64-bit versions of Windows. However, drivers designed for 32-bit versions of Windows do not work on computers running a 64-bit version of Windows. You will have to obtain 64-bit drivers for your devices, but you need not worry too much since most driver cd’s these days come with both 32 and 64 bit drivers. Its only a matter of concern for older hardware, especially the ones for which the company has stopped support and updating drivers.

Would you benefit from using a 64-bit computer?

Yes. You will have more RAM available to you and you will finally be able to utilise your entire 4GB or higher amount of RAM. Apart from that, 64-bit Operating system is more efficient in handling memory intensive programs and from our experience softwares like Photoshop, 3D Studio Max and others which have separate 64-bit versions for 64-bit Operating systems run smoother than their 32-bit counterparts.

1.5 System requirements

Microsoft lists the minimum system requirements for Windows 7 on its website as:

- 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor (Windows XP stated this as 300 MHz; whereas Vista’s bare necessity was the same.)
- 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit) (Windows XP needed just 128 MB minimum but again, it’s the same as Vista’s)
- 16 GB available hard disk space (32-bit) or 20 GB (64-bit) (Windows XP required just 4.2 GB in contrast whereas Vista for some reason stated 20 GB
for 32 bit and a massive 40 GB for 64-bit variant as its minimum.)
- DirectX 9 graphics device with WDDM 1.0 or higher driver (Again, it's the same as Vista’s. XP with its modest graphics just required a Super VGA graphics device.)
- Additional requirements to use certain features:
  - Internet access
  - Depending on resolution, video playback may require additional memory and advanced graphics hardware
  - For some Windows Media Center functionality a TV tuner and additional hardware may be required
  - Windows Touch and Tablet PCs require specific hardware
  - HomeGroup requires a network and PCs running Windows 7
  - DVD/CD authoring requires a compatible optical drive
  - BitLocker requires Trusted Platform Module (TPM) 1.2
  - BitLocker To Go requires a USB flash drive
  - Windows XP Mode requires an additional 1 GB of RAM, an additional 15 GB of available hard disk space, and a processor capable of hardware virtualization with Intel VT or AMD-V turned on
- Music and sound require audio output

We saw how it compares with Vista and XP and even though its an upgrade to Vista, system requirements haven’t increased at all. We’ve even tested Windows 7 on a machine with 1.6 Ghz Intel Celeron processor and 512 MB RAM with 32 MB shared for Video Memory and it seemed pretty usable for most basic tasks. Even though almost the entire ram was used all the time, working on multiple tabs in Firefox, word processing and music playback simultaneously was not outright painful. While that system handles Windows XP fairly well, Vista just kills it and renders it unusable even for internet browsing.

We, however, do not recommend you to install Windows 7 on anything lesser than 1GB RAM but you can give it a spin if you intend to use your computer as a netbook and all of your hardware is compatible. You can check that with a handy utility called the Windows 7 Upgrade Advisor which we shall be talking about next. Its like a ‘First Things First’ before you get down to installing Windows 7 or even considering it for your computer if your machine doesn’t boast of the latest hardware and all the RAM you will ever need.

1.6 Windows 7 Upgrade Advisor
Microsoft provides this really handy tool called "Windows 7 Upgrade
Windows 7 Advisor" which scans your PC and lets you know if your system is capable of running Windows 7 and explains any potential compatibility issues.

In general, if your PC/laptop had Windows Vista, it can run Windows 7 and from our experience, most computers handle Windows 7 better than Vista. But if you were sticking to Windows XP and don't have one of those "Vista Ready" branded computers, this utility will come very handy.

Just download, install and launch the application. It will scan your computer and any external device connected to your computer like printers, scanners etc. for compatibility with Windows 7 and generate a detailed report with potential issues and suggestions to resolve them. For example, it might let you know that you need an updated driver for your Graphics Card and can direct you as to where to get it.
Installation

Whether you want to set up a dual-boot system, you’re ready to migrate all the way to Windows 7 from XP, or something in between, here’s what you need to know for installing and playing with Windows 7 and fear not, thy noble purchaser of legal software: its (mostly) painless.

Microsoft offers several paths to install Windows 7. You can upgrade from Windows XP or Vista, or do a clean install on your computer. The clean install process took us exactly 18 minutes on a modestly spec-ed machine and it has been our fastest experience right from Windows 3.1 to a bloated Windows Vista.

The upgrade procedure is different depending on whether you’re currently running Windows XP or Windows Vista. Windows 7 provides a direct upgrade path to Windows 7 from Vista. This means that when you install Windows 7, all you need to do is select the Upgrade option during Windows 7 installation. Note: Windows 7 requires that you’ve installed Vista Service Pack 1 over your base Vista installation in order to upgrade.
Unfortunately, Windows 7 doesn’t provide a direct Upgrade path for Windows XP users, and you have to go through the whole process of backing up your data, formatting and installing Windows, and then restoring your files and settings using the 'User State Migration Tool' which moves all your desktop, application and system settings apart from your files to a new Windows installation. It is kind of like Microsoft’s punishment for skipping Vista, but Microsoft has made sure not to alienate XP users and they’ve provided a series of videos detailing how to migrate from XP to Windows 7 on their website.

Let us get down to installing Windows.

2.1 What are your options?
You’ve two options from the default installer:

Upgrade to Windows 7 – This option upgrades your current operating system and keeps your files, settings and programs as they are presently.

Install Windows by performing a custom installation – This option is used to completely replace your current operating system, or to install...
Installation

Windows on a separate partition for multi-boot. This is your only choice if your computer does not have any operating system. This option also gives you advanced Disk Management features such as Format, Extend partition, Create or Delete partition if you have booted your computer using the Windows Installation Disc and not using the setup.exe from your existing Windows installation.

A custom installation does not retain any of your programs or settings. If you delete or formatted the partition that holds your current Operating system, all data on that partition, including programs, files and settings would be permanently deleted once you go with the installation process.

However if you decide not to format or delete the Windows partition and install Windows 7 on top of it, all your user files will be saved in a 'Windows.old' folder automatically on the same partition. While this does not delete your previous files, your encrypted files will be rendered useless in the new Windows. So, we recommend you to back them up before performing a Custom Install. You can delete the 'Windows.old' folder using Disk Cleanup Utility on your Windows partition.

2.2 Install Windows by performing a custom installation

You can choose one of the following options:

• If your computer already has some version of Windows installed and you want to replace it with Windows 7 without making any changes to your partitions, boot into it, insert the Windows 7 installation disc into the DVD drive or mount its image using PowerISO or Daemon tools and the likes. Then open the Autorun File or Setup.exe.

• If your computer doesn’t have an operating system installed or if you want to create, extend, delete, or format partitions, you need to restart your computer with the installation disc inserted in your DVD drive. This causes your computer to start (or "boot") from the installation DVD. If you are asked to press a key to boot from DVD or CD, press any key. For this to appear, ensure that your DVD drive is set
as your first boot device in BIOS. Some manufacturers even give the option of selecting the boot device from a menu without entering BIOS by pressing some function key. Check the first screen that appears when you start your comp for that.

- You will see the Install Windows page. Click on Install now.
- On the "Get important updates for installation page", we recommend getting the latest updates for better driver compatibility and latest security patches. You will need an Internet connection for this. If you use a proxy for connecting to the net, enter it in your IE settings.
- Next, check the “I accept the license terms” option on the Please read the license terms page.
- Click on Custom when you get to the ‘Which type of installation do you want?’ page
- Next you will get the “Where do you want

**Note**

If you use a fingerprint reader or another biometric device to log on to your computer, make sure you write down your password before upgrading. You can log on only by typing your user name and password the first time you use Windows after upgrading.
Installation

to install Windows?” page. Do one of the following:
• If you don’t want to specify a specific partition to install Windows on, or create partitions on your hard disk, click on Next to begin the installation.
• If you already have another existing partition with enough free space and want to have more than one operating system on the same computer, you can install Windows on that partition. This is called a dual-boot or multiboot configuration depending on the number of Operating systems installed. Make sure to install Windows on a different partition from the partition where your other versions of Windows are installed. Select the partition you want to use, and then click on Next to begin the installation.
• If you want to create, extend, delete, or format a partition, click Drive options (advanced), click the option you want, and then follow the instructions. Click on Next to begin the installation. The Drive options (advanced) option is disabled if you have started the installation from your previous Windows and not booted from the installation disc.
• Now just follow the instructions and you should be set with a new Windows 7 in no time.

2.3 Install from a Pendrive
Let’s see how you can create a bootable USB disk to install Windows 7 which is handy when installing Windows on a system that may not have a DVD drive (or any drive at all).

The method is very simple and you can use it without any hassles or expert knowledge. Needless to say that your motherboard should support booting from USB drives for this feature to work. There are a few requirements that
Installation Windows 7

Requirements:

- USB Flash Drive (4GB. If possible, get a 4GB only and not 8 or 16 GB as they take an eternity to format.)
- Windows 7 or Vista installation DVD or iso.
- Follow these steps to create bootable Windows 7/Vista USB drive using which you can install the Operating systems without booting from DVD or starting the installation from an already installed Windows.
- Open an elevated Command Prompt with admin rights. To do this, type cmd in Start menu search box and hit [Ctrl]+ [Shift]+ [Enter].
- Go to Start menu > All programs > Accessories, right click on Command Prompt and select Run as administrator.
- Type in the following commands in the command prompt:
  - DISKPART
  - Next type LIST DISK command and note down the Disk number (ex: Disk 1) of your USB flash drive.
  - Assuming your Pendrive is “Disk 1”. Type SELECT DISK 1, then CLEAN CREATE PARTITION PRIMARY

Select your Language and Time settings and click on Next

need to be kept in mind.

Thinkdigit.com
Installation

- SELECT PARTITION 1
  ACTIVE
  FORMAT FS=NTFS
- This process takes quite some time.
  ASSIGN
  EXIT
- Don’t close the command promp. Just minimise it.
- Insert your Windows7/Vista DVD into the optical drive or mount the ISO using PowerISO or Daemon Tools or something like that and check the drive letter of the DVD drive. I am assuming that your DVD drive letter is “F” and USB drive letter is “I”
- Type ‘F:’ in Command Prompt where F is your DVD drive letter.
- Type CD_BOOT
- Type ‘BOOTSECT.EXE/NT60 I:’ where I is your USB drive letter to update the USB drive with BOOTMGR compatible code and make it bootable.
- Now, back in Windows Explorer, simply drag and drop all the files from the mounted ISO image or the DVD onto the USB disk creating a copy of the installation disk.

Your USB drive is now ready to boot and install Windows 7/Vista. Then, with the USB disk inserted, reboot the machine and change the boot priority at the BIOS to USB from the HDD or CD ROM drive. The system should now boot from the USB disk we created and start the installation. The rest of the setup process should be identical to installing from a DVD disk. That’s all there is to it!
Hardware Support

3.1 Windows 7 device Experience
There was a time when people relied on their desktops and laptops for information, communication and entertainment. But mobiles, PMP’s and other devices have taken over that domain and boast of rich applications, services and data capabilities of their own while having the ability to connect to your computer locally or wirelessly and syncing seamlessly.

While Windows XP and Vista provided a component and function-centric view of devices courtesy the 'Device Manager', Windows 7 takes it a step further with 'Devices and Printers' and 'Device Stage' which enables you to use and manage devices in a more enjoyable way. Installation of new devices such as printers, cameras, phones, music players and access to their configuration settings, applications and common tasks specific to the device was never this natural with very little to no learning curve. It even helps the device makers to integrate their device experience, unique features, services and branding directly into Windows in a flexible but consistent manner.

3.2 Devices and Printers
The new Devices and Printers folder available from the Start Menu shows
you all the external devices connected to your PC, mainly the ones users can touch and feel and not abstract components inside the computer.

It is a handy way to check on portable devices which you carry with you and occasionally connect to your computer, such as mobile phones, portable music players, photo frames and digital cameras besides all the devices connected via USB, or paired via Wi-Fi or Bluetooth wireless interface including external USB hard drives, flash drives, webcams, keyboards, and mice.

As the name suggests, it also displays all printers connected to your computer, whether it is via USB, the network or wirelessly. Some compatible network-enabled scanners, media extenders and Network Attached storage devices (NAT) are also supported by this.

A multifunction printer now shows up as a single device in Devices
Windows 7

and Printers, not as a collection of three or four components like it is displayed in the more conventional Device Manager. However, the Devices and Printers folder doesn't display the devices installed inside your computer case, such as internal hard drives, disc drives, sound cards, video cards (graphics cards), memory (RAM), processors, and other internal computer components for which you still need to head towards the 'Device Manager' located in the Control Panel. Certain devices such as speakers connected to your computer with conventional speaker wires and keyboards and mice connected through a PS/2 or serial port are also not supported by this yet.

Device manufacturers do not have to do anything for their devices to show up in 'Devices and Printers'. But if they want to, they can customize the experience the user will have by using a new set of custom XML schemas. They can also develop custom context menu handlers like a list of tasks that vary depending on the capability of the device to be shown when the user right-clicks on the device. For example, you might be able to see what's printing on a network printer; view files stored on a USB flash drive, or open a program from the device manufacturer. For mobile phones that support the new Device Stage feature in Windows, you can also open advanced, phone-specific features in Windows from the right-click menu, such as the ability to sync with the phone or change ringtones.

Besides letting you view information about your devices, such as make, model, and manufacturer, including detailed information about the sync capabilities of a mobile phone or other mobile device, Devices and Printers is also an excellent place to check if a specific device is working properly and then troubleshoot problems in case they arise.

3.3 Device Stage

Many operating systems have pre-installed drivers for printers, scanners and other products, but Device Stage takes the concept to a ridiculously thorough level, with not just drivers but specialized icons, pop-up menus and XML pages full

Device Stage for a mobile phone with its various options
Hardware Support

of things you can do with your camera, printer, scanner, phone or whatever. When you plug in a Windows 7 compatible device, you'll see its status and a list of popular tasks. If the manufacturer has included a XML schema, you can even see a picture of your device.
Exploring the new desktop

4.1 New taskbar

The taskbar is the biggest change from all previous versions of Windows including Vista and its one of the best we’ve seen from Microsoft. It seems like the dock of OS X or Rocket Dock on windows at first, but it works differently and closely integrated with the OS. You can pin any application or folder on the taskbar and it tracks and groups instances of them irrespective of the fact whether they are open or closed.

If you multitask a lot, you will be familiar with the problem of too many open windows getting piled up on the desktop and the taskbar. It becomes hard to see what else is underneath or remember what you’ve already opened. That’s where the taskbar comes in handy. Whenever you open a program, folder, or file, Windows creates a corresponding button on the taskbar showing just an icon that represents the open program.

With the new Progress Bar integrated into the task bar, you can monitor ongoing tasks and processes performed by their applications without having to keep the programs' window visible. The progress of functions including file copies, CD and DVD burning, downloads and installs is displayed dynamically via the Taskbar buttons, through the Progress Bar.

When you move your mouse pointer to a taskbar button, a small picture appears that shows you a miniature version of the corresponding window. This along with Aero Peek, which makes every window on the desktop transparent except the one you’re highlighting at the moment, makes sure that you find any window nearly instantly, no matter how many windows your desktop is buried under. To switch to another window, just click on the miniature version that pops out from its taskbar button. You can even close it by middle-clicking, a feature which is common to most applications that use tabbed browsing.
4.2 Jump Lists
In applications coded to take advantage of the jump list, when you right-click an icon, you’ll get a pop-up menu which will give you quick access to recently opened items, frequently opened items, tasks, or websites, in addition to any favorite items you’ve decided to pin. In Internet Explorer, it shows your recent browsing history; in Windows Media Player, it’ll let you play recent videos; and Windows Explorer will give you quick access to frequently used folders and files. You can also pin favorites to a Jump List, so you can quickly get to the items that you use frequently. Jump Lists on the taskbar contain several menu commands that you can use to close an item or unpin the program from the taskbar. You can even drag an item off of a Jump List to copy it to another location or folder. For now, lets see what all you can do with this feature.

4.2.1 Display More Items on Jump Lists
If you have a high pixel density screen, you probably can afford to increase the number of items that show up on the list. For this,
• Right click on the Start button and Open properties
• Open the Start Menu tab
• Click on Customize
• At the bottom of the window, there’s an option to put “Number of recent
Windows 7

items to store in Jump-lists”.
- Set it to whatever value you think will be sufficient while not intruding too much on screen real-estate. Experiment to your liking.

4.2.2 Quick Access to Media
Windows Media player, ITunes 9 and Zune Player, all let you quickly access your frequently used media, playlists apart from letting you quickly pause/play, go to next/previous song and rate your music from Jumplists. Its worth checking out. Even Winamp boasts of similar functionality with latest versions.

4.2.3 Open Private Browsing or Bookmarks Easily
Private browsing has been there in IE and Chrome for quite some time now. But accessing it takes opening the program and going through a couple of steps, navigating to the option and then activating private browsing mode. But with Jumplists, it’s just two clicks away from the desktop. Both of the browsers let you quickly open a private browsing window by giving an option there itself.

4.2.4 Pin Folders and Searches To the Taskbar
This is by far our favorite feature of JumpLists and saves a lot of time by giving instant access to recently used folders and frequent searches,
Exploring the New Desktop

for example the documents modified in the last hour for finding recently worked on files. Just open up the Windows 7 search, put in your search criteria, and then drag the icon from the location bar down to the Windows Explorer taskbar button to pin the search there.

4.2.5 Clear Jump-List History
Every good thing brings something bad along with it. It puts your privacy at risk especially if you share the computer with other people as they can very conveniently see your history and what documents you opened and what videos you watched. So, you should know how to clear items from jumped lists.

- Right click on the Start button and Open properties
- Select the Start Menu tab.

Open Recently accessed folders quickly

Uncheck and check those boxes to delete recent history from quick lists

Jumplist with most frequently accessed files and pinned tasks
Windows 7

• To prevent recently opened programs from appearing in the Start menu, just clear the “Store and display recently opened programs in the Start menu” check box.
• To clear recently opened files in the Jump Lists on the taskbar and Start menu, just clear the “Store and display recently opened items in the Start menu and the taskbar” check box, then click on Apply.
• To begin displaying recently opened programs and files again, tick the check boxes again, and then click on OK.

Windows 7 also remembers your PC search queries, and displays the most recent examples when searching in Windows Explorer by default. This can often prove to be irritating for the same aforementioned reason. But you have an option to disable it.

Run gpedit.msc from the run dialog box, then go to User Configuration > Administrative Templates > Windows Components > Windows Explorer and double click on “Turn off display of recent search entries”.

4.3 Aero Peek

Aero Peek is a big part of what makes the new taskbar so useful. When you open multiple windows on the desktop, it can sometimes be a challenge to find and view different windows and switch between them. But you can use Aero Peek to take a quick look at other open windows without clicking away.
Exploring the New Desktop

from the window you are currently working on. It allows you to preview the contents of open windows by blacking out everything else so that you can switch to the one you want.

When you highlight the thumbnail preview of an app window that you might want open, it makes every other open window transparent, so you get a clear view of the window you’re looking at. Or, if you hover over a small button on the bottom right corner of the taskbar, all open windows will fade from view, for a quick peek at your desktop, gadgets, or Windows 7’s free-floating widgets.

4.4 Aero Shake

You can use Aero Shake to quickly minimize every open window except the one you’re shaking. It is a useless-but-neat feature that clears all the clutter for you without you having to minimize each and every window apart from the one you want to focus on. It is just a mouse gesture that lets you grab the title bar of the window you wish to keep open and give it a shake, and enjoy in a clear desktop area. Of course, you can use Win+ Home key for the same functionality. It just adds that Zing to the new UI. You can even restore all of those windows by shaking the open window again.

4.5 Aero Snap

This is probably one of the most under hyped features of Windows 7. It makes life so much simpler especially if you have a widescreen monitor or a multi monitor setup. Just grab a window and throw it (not literally) to the top to maximize it. Pull it down and it will restore to original size again. Drag it to one side and it will tile to fill half the screen real estate. Dragging it to another monitor also becomes easy as it does not lose its state. It is very intuitive and soon becomes second nature when comparing two documents, copying or moving files between two windows, maximizing the window you’re currently working on, or expanding long documents so they’re easier to read and require less scrolling. On tablets, you can just swish your finger to the top to maximize. Probably not all that useful but an indication of the things to come in future UIs.

Just in case you find this feature distracting, remember that it can be easily disabled. Run REGEDIT from the Run Command dialog box, go to HKEY_CURRENT_USER\Control Panel\Desktop, set WindowArrangementActive to 0, and reboot. Now your windows will behave just as they always did.
4.6 Other mouse gestures
Windows 7 has not only brought gestures for those who use touchscreen devices, but for mouse users too. So, instead of right-clicking a Taskbar icon to access its jump list, you can press and hold left-click and drag upwards (Outwards from the Start bar) to smoothly call it up. Similarly, clicking and dragging down the address bar in IE opens the browsing history.

4.7 Desktop Gadgets
Windows Sidebar isn't included in this version of Windows. Instead, you can have gadgets anywhere on your desktop in Windows 7 and use the Aero Peek features to temporarily view your desktop gadgets without minimizing or closing the windows you’re working with. Gadgets are mini-programs, which offer information at a glance and provide easy access to frequently used tools. For example, you can use gadgets to display your CPU and RAM usage, view a picture slide show, view continuously updated headlines through feeds, or look up contacts. This way, if you want to keep track of what’s happening in the news while you work, you don’t have to stop what you’re doing to switch to a news website. If you see a headline that interests you in the feeds, you can click that headline, and your web browser will open directly to the story.
4 Exploring the New Desktop

Before a gadget can be added, it must be installed on your computer. To see which gadgets are installed on your computer, do the following:

• Right-click anywhere on the desktop and click on Gadgets.
• To see more information about a gadget, select it, and then click on Show details.

Adding gadgets to your desktop

• To add a gadget, double-click on a gadget to add it to your desktop instantly.

When you right-click a gadget, you'll see a list of things you can do with the gadget, including closing it, keeping it on top of your open windows, and changing its options. Even if you point to a gadget, a Close button and an Options button will appear near its upper-right corner. Some gadgets also have an option of varying their size.
Exploring the New Desktop

The Windows 7 website has a good collection of gadgets for you to download and install. You can add any gadget that’s installed on your computer to the desktop. If you want, you can even add multiple instances of a gadget. For example, if you are constantly on the move between countries and need to keep track of time in different time zones, you can add multiple instances of the Clock gadget and set the time of each of them accordingly.

To remove a gadget, right-click the gadget, and then click Close Gadget.

You can also drag a gadget to a new position anywhere on the desktop.

8. Working with libraries

In all previous versions of Windows, managing your files meant organizing them in different folders and subfolders. Windows 7 comes with its concept of libraries, which makes it easier to find, access, work with and organize files scattered across your computer or even over the network regardless of where they are stored. From our experience, it’s a huge productivity boost and you get more work done generally.

In some ways, a library is similar to a folder in concept. It aggregates files from different locations and displays them as a single collection. However, unlike a folder, a library gathers files that are stored in several locations without actually storing your items or moving your files from the original folder. This is a subtle, but important, difference. Libraries monitor folders that contain your items, and let you access and arrange the items in different ways like 'documents by type', 'pictures by date taken' and 'music by genre'.

Say you have three video folders (Movies, TV shows and You-tube rips). Or you are assembling your music collection with some songs stored on an
Exploring the New Desktop

external hard-drive, some stored on your friend’s laptop connected over a network and some in your work computer. With Windows Vista or XP, hunting down specific songs would have been a tedious chore. But with libraries, you can merge them into one by telling Windows which far-flung folders should be included in your new library and have instant access to all your files at once even though they are still physically stored in different locations. Public Folders also merge into libraries so your whole network can have seamless access to your public files. This feature is particularly useful if you have a home media server because you can now access the media on the server without navigating to mapped drives.

Here are some things you can do with libraries:

4.8.1 Create a new library.

There are four default libraries (Documents, Music, Pictures, and Videos). Besides them, you can also create new libraries for other collections.

To create a new library
• Click the Start button, click your user name or any other Windows Explorer window, and then, in the left pane, click Libraries.
• In Libraries, click New library on the toolbar.
• Enter a name for the library, and then press Return key.

To copy, move, or save files to a library, you must first include a folder in

Add a new library like this
the library so that the library knows where to store the files. This folder will automatically become the default save location for the library.

4.8.2 Include folders in a library
You can include up to 50 folders from different locations in the same library, and then view and arrange the files in those folders as one collection.

To include a folder from your computer in a library
- Open Windows Explorer
- Right-click the folder that you want to include, point to Include in library, and then click a library.

To include a folder from an external hard drive in a library, make sure the external hard drive is connected to your computer and that your computer recognises the device.
- Open Computer from the Start Menu.

Including specific folders in your libraries.
Exploring the New Desktop

- Navigate to the folder on your external hard drive that you want to include.
- Right-click on the folder, move your mouse pointer to 'Include in library', and then select the desired library.

A network folder must be added to the index before it can be included in a library if it is on a network device that is not part of your homegroup.

If the network folder is not indexed, just make the folder available offline. This will create offline versions of the files in the folder by locally storing them, and add these files to the index on your computer. Once you make a folder available offline, it can be included in a library. When you make a network folder available offline, copies of all the files in that folder will be stored on your computer’s hard disk. If the network folder contains a large number of files, it is not advisable to follow this.

To make a folder available offline:

- While connected to the network, locate the network folder that you want to make available offline.
- Right-click on the folder, and then select ‘Always available offline’.

The Always available offline command

To include this in your library
- Open ‘Computer’ from the Start menu.
- In the navigation pane (the left pane), click Network, and then navigate to the folder on your network that you want to include, or type the path of the network in the address bar.
- Right-click the folder, move the cursor to Include in library, and then select your desired library.

4.8.3 Customize a library

You can also customize the general behavior of a library by changing its default save location, or by changing the type of file that a library is optimized for.

Notes

- The content of the folder will only be available when the device is connected to your computer.
- Folders from removable media devices (such as CDs and DVDs and Blu-ray discs) and some pen-drives can’t be included in a library. Saved searches and Search connectors can’t be included too.

Notes

If you don't see the Always available offline command, you might be using an edition of Windows 7 that doesn't support offline files.

Notes

If you don't see the Include in library option, it means that the network folder is not indexed or is not available offline.
To change a library's default save location

A library's default save location determines where an item will be stored when it's copied, moved, or saved to the library. To change a library's default save location:

- Open the library you'd like to change.
- Click on ‘x’ locations link next to Includes above the area where files are displayed.
- In the Library Locations dialog box, right-click a library location that's not currently the default save location, click Set as default save location, and then click OK.

To change the type of file a library is optimised for

Each library can be optimized for a certain file type, such as music or pictures. This changes the options that are available for arranging the files in that library.

- Right-click the library you'd like to change, and then click on Properties.
- In the "Optimize this library for" list, click a file type that constitutes the major part of the library, and then select OK.

4.8.4 What happens when you delete a library or the items in a library?

If you delete a library, the library itself is moved to the Recycle Bin. However, the files and folders that were accessible in this library are stored elsewhere and therefore aren't deleted.

But if you delete individual files or folders from within a library, they are also deleted from their original location. If you want to remove an item from a library but not delete it from the location it's stored in, you should remove the folder containing the item.

To remove a folder from a library,

- Open Computer from the Start Menu.
- In the navigation pane (the left pane), select the library that you want to remove folders from.
- Click on “<x> locations” link next to ‘Includes’ above the area where files are displayed.
- In the subsequent dialog box, select the folder you want to remove, click Remove, and then press OK.
Exploring the New Desktop

4.9 DirectX 11
Windows 7 comes with a new version of DirectX, a graphics and sound standard which delivers better image quality, eye-popping 3D visuals, immersive sound effects and improved performance vital to many of today’s PC games.

This version of DirectX is refined to leverage the power of multi-core processors to deliver sophisticated shading and texturing techniques such as tessellation, more efficient Anti-Aliasing and Vsync, smoother 3D lifelike graphics and nuanced sound.

You can check the version of DirectX on your system by Opening the DirectX Diagnostic Tool. Just Open the Run Command Dialog box by pressing Win+R and entering dxdiag.

In it, check the System Information in System tab for the DirectX version number.

4.10 Improved Search
Windows 7’s native search feature has been improved. Files added to the hard drive get indexed instantly and we could see them in less than 10 seconds.

Just start typing the name of a file, a folder, a program, or even text you know appears within a file—pretty much anything in the Start Menu and search results will start showing up, organised by category. When you see what you’re looking for in the list of search results, left click on it to open. Or, if you don’t see what you’re looking for in the visible list, click on a category. You can also click on ‘See more results’ to view the complete list of search results in Windows Explorer.

Search result also has snippets which are longer than what was available in Vista and highlights relevant items in your files and documents, revealing important searching from the start-menu.
data even if it's not in the file name. This should appeal specifically to people who handle lots of documents and eBooks, but it's a useful feature for anybody who wants to find stuff faster. The search field is available by default in the Start menu and in Windows Explorer, apart from the option of pinning them on Jumplists.

### 4.11 Windows Experience Index

The Windows Experience Index is a hardware rating system, first introduced in Windows Vista. It measures the capability of your computer's hardware and software configuration and expresses this measurement as a number called a base score ranging from 1.0 to 7.9.

The score is calculated after the utility performs various tests benchmarking the CPU, Memory, Graphics and Hard-
disk etc. Each of the components receive an individual subscore. Your computer’s base score is determined by the least of the subscores. For example, if the lowest subscore of an individual hardware component is 4.9, then the base score is 4.9.

To view the Windows Experience Index, Right click on Computer button in the Start Menu and open Properties from the menu that appears. In this System Properties dialog box you can see your computer’s base score.

Windows Experience Index may not be available as soon as you install the OS. To activate:

- Click on the “System rating is not available” link to start the tests in the Performance Information and Tools dialog box.
- Click on the “Rate this computer” button to start the performance evaluation tests. It may take a few minutes depending on your computer’s hardware.

You may use the Re-run the assessment link to recalculate the score at any time. Once you change any of the critical hardware in your computer, you have to be refresh or Re-run the assessment. To view more detailed information about the hardware on your computer, click on ‘View and print details’.
Accessibility and Voice Recognition

Windows 7 gives you more ways to interact with your PC by taking advantage of new strides in speech recognition and touch technology.

### 5.1 On-Screen Keyboard

On-Screen Keyboard lets you type without using the keyboard and Windows 7’s on-screen keyboard is touch optimised for Tablets. There are several different input methods: clicking mode, hovering mode, and scanning mode. With Windows Touch and the right touch-enabled hardware, you can also input text by tapping directly on the screen. It even incorporates iPhone esque word prediction which speeds things up: type the first few letters of a word, and Windows will finish it for you.

### 5.2 Narrator and visual notifications

Windows 7 can read aloud on-screen text, events and error messages, helping you use your computer with voice assist. With Audio Description, you can hear a narration of what’s happening in a video. Windows 7 can also replace sound alerts with visual cues like a screen flash and pop-up messages so system alerts are noticeable even when they’re not heard.

Windows Narrator, reads text on the screen aloud and describes some events (such as an error message appearing) that happen while you’re using the computer.
Accessibility and Voice Recognition  Windows 7

Open Narrator by clicking on the Start button, clicking All Programs, clicking Accessories, clicking Ease of Access, and then clicking Narrator.

Use the keyboard shortcuts in the following table to specify which text you want Narrator to read:

<table>
<thead>
<tr>
<th>Use this keyboard shortcut</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+Spacebar</td>
<td>Read the entire selected window</td>
</tr>
<tr>
<td>Ctrl+Alt+Spacebar</td>
<td>Read the items that are selected in the current window</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Stop Narrator from reading text</td>
</tr>
<tr>
<td>Insert+F2</td>
<td>Select all of the text that has the same formatting as the character at the cursor</td>
</tr>
<tr>
<td>Insert+F3</td>
<td>Read the current character</td>
</tr>
<tr>
<td>Insert+F4</td>
<td>Read the current word</td>
</tr>
<tr>
<td>Insert+F5</td>
<td>Read the current line</td>
</tr>
<tr>
<td>Insert+F6</td>
<td>Read the current paragraph</td>
</tr>
<tr>
<td>Insert+F7</td>
<td>Read the current page</td>
</tr>
<tr>
<td>Insert+F8</td>
<td>Read the current document</td>
</tr>
</tbody>
</table>

To choose which text Narrator reads aloud
Under Main Narrator Settings, select one or more of the following:
• Select the Echo User’s Keystrokes check box to hear what you type.
• Select the Announce System Messages check box to hear background events, such as notifications.
• Select the Announce Scroll Notifications check box to hear an announcement when the screen scrolls.

To change the Narrator voice:
• Open Narrator
• Click Voice Settings, and then make any of the necessary adjustments.

To select a different voice, click

Note
The Insert key is used for Narrator commands, so when you press Insert while Narrator is running, you won’t be able to insert characters. To use the Insert key to insert characters while Narrator is running, press Insert+I and then the characters you want to add.

Change advanced Narrator settings from this menu
the voice you want to use in the Select Voice box.
• For a faster voice, select a number in the Set Speed list.
• For a louder voice, select a number in the Set Volume list.
• For a higher-pitched voice, select a number in the Set Pitch list.

5.3 Windows Speech Recognition
Input devices to you mean a keyboard to type out text, enter commands etc and the mouse to navigate and launch files. But Windows 7 comes with WSR (Windows Speech Recognition) that gives you a new dimension of interface control; your voice to control, command and dictate text to your computer. While Vista users will be familiar with WSR, it is a new feature to most XP users who never used any Voice Recognition software like ‘Dragon Naturally Speaking’. Windows Speech Recognition has fairly high recognition accuracy for something that comes bundled free with an Operating System and has an extensive list of commands to control your computer. The text dictation feature, although not very good with the Indian accent works fairly well for small jobs. Instead of
Accessibility and Voice Recognition

using the keyboard, you can just sit back and command your computer to start an email by recipient’s name, surf a webpage, pause/play a song or just dictate out an occasional mail.

5.3.1 What exactly can you do with Speech Recognition?

Enough of talking vaguely. Lets get down to what exactly can you do with Speech Recognition?

Control your Computer

Speech Recognition recognizes standard commands like Click File, Right Click Computer, Copy that, Paste, Minimize, Play, Show Desktop, etc and responds to spoken commands and performs the specific task if the program supports that command. You can use WSR to run programs and interact with Windows in a natural way. Even with applications that don’t support ‘commands’, you can work your way around with what is known as geography control. You can ask Windows to overlay numbers on top of the elements in the program interface and then subsequently activate that function speaking out the number on top of it. Even if this doesn’t work, there’s the option of Mouse grid for programs that need mouse clicks in arbitrary locations. This option presents you with a grid with nine zones with numbers inside each.

When you speak a number, that zone gets selected, the mouse moves to that zone and another nine zone grid is created inside that zone. This process keeps on repeating until you place the mouse cursor in the exact place where you want to click.

Dictate and edit text

You can use Speech Recognition to dictate words into word-processing programs, to fill out online forms in a web browser, or to type an email in Outlook/ThunderBird. You can also use Speech Recognition to edit text on your computer. As we mentioned, it is by defaul tailored to suite an American accent, but with training, you can make it fairly accurate. It will not become a replacement for your secretary but will surely help you reply to your mails at the end of a hectic day.

But, before you get really excited about WSR and think of firing your
PA in the recession-hit economy, remember that it works well only when used with a good microphone. We gave it a spin using the standard microphone that comes bundled with laptops and found ourselves shouting out loud and still getting weird responses. When we tried speaking softly, WSR replied “Did you say something?” “Please speak in English.” “Are you Human?”. Ok. Not the last one.

However performance with microphones was acceptable and when tried with a Bluetooth headset (The one that came free with your new mobile phone in some festive offer), it seemed to work fine almost all of the time including dictation, albeit after a little training. Avoid cheaper microphones since they tend to pick up a lot of background noise and hissing.

### 5.3.2 Set up Speech Recognition

Before you get started using Speech Recognition, you’ll need to set up your computer for Windows Speech Recognition. There are three steps to setting up Speech Recognition: Set up your microphone, Learn how to talk to your computer, and Train your computer to understand your speech.
Accessibility and Voice Recognition

Before you get started, make sure that your microphone is connected to your computer.

Set up your microphone
Open Windows Speech Recognition by typing it in the Start Menu search box. Click Set up microphone and then follow the instructions on the screen.

Set up your microphone to ensure WSR doesn't pick up background noise

Window that comes to guide you through the 'Set up Microphone'

Adjust the volume of Microphone (High Definition Audio Device)

Read the following sentences aloud in a natural speaking voice:

"Peter dictates to his computer. He prefers it to typing, and particularly prefers it to pen and paper."

Note: After reading this, you can proceed to the next page.

Reading out sentences to calibrate your microphone
Teach yourself how to talk to your computer
Windows comes with a speech training tutorial to help teach you the commands used with Speech Recognition. The tutorial takes about 45 minutes to complete. Follow the steps after clicking on Take Speech Tutorial in the Windows Speech Recognition window.

Train your computer to recognize your speech
Speech Recognition associates a unique voice profile to your User Account to recognise your voice and spoken commands. As you use Speech Recognition, your voice profile gets more detailed, which should improve your computer’s ability to understand you.

Open Speech Recognition and Click on Train your computer to better understand you.
5.3.3 Frequently used commands

The following table shows some of the most commonly used commands in Speech Recognition.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click any item by its name</td>
<td>Click File; Insert; View</td>
</tr>
<tr>
<td>Click any item</td>
<td>Click Recycle Bin; Click Libraries; Click file name</td>
</tr>
<tr>
<td>Double-click any item</td>
<td>Double-click Recycle Bin; Double-click Libraries; Double-click file name</td>
</tr>
<tr>
<td>Switch to an open program</td>
<td>Switch to Notepad; Switch to WordPad; Switch to program name; Switch application</td>
</tr>
<tr>
<td>Scroll in one direction</td>
<td>Scroll up; Scroll down; Scroll left; Scroll right</td>
</tr>
<tr>
<td>Show a list of applicable commands</td>
<td>What can I say?</td>
</tr>
<tr>
<td>Make the computer listen to you</td>
<td>Start listening</td>
</tr>
<tr>
<td>Make the computer stop listening</td>
<td>Stop listening</td>
</tr>
<tr>
<td>Ask for help</td>
<td>How do I do something?</td>
</tr>
</tbody>
</table>

For example, say “How do I install a scanner?” and a list of help topics is returned.

Dictation

These are commands for working with text. The following table shows commands for using Speech Recognition to work with text.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a new line in the document</td>
<td>New line</td>
</tr>
<tr>
<td>Insert a new paragraph in the document</td>
<td>New paragraph</td>
</tr>
<tr>
<td>Insert a tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Put the cursor before a specific word</td>
<td>Go to word</td>
</tr>
<tr>
<td>Put the cursor after a specific word</td>
<td>Go after word</td>
</tr>
<tr>
<td>Go to the start of the document</td>
<td>Go to start of document</td>
</tr>
<tr>
<td>Go to the end of the current document</td>
<td>Go to end of document</td>
</tr>
<tr>
<td>Select the word in the current document</td>
<td>Select word</td>
</tr>
<tr>
<td>Select the word range in the current document</td>
<td>Select word range; Select word through word</td>
</tr>
<tr>
<td>Select all text in the current document</td>
<td>Select all</td>
</tr>
<tr>
<td>Select the last text you dictated</td>
<td>Select that</td>
</tr>
<tr>
<td>Clear the selection on the screen</td>
<td>Clear selection</td>
</tr>
<tr>
<td>Delete the previous sentence</td>
<td>Delete previous sentence</td>
</tr>
<tr>
<td>Delete the next sentence</td>
<td>Delete next sentence</td>
</tr>
<tr>
<td>Delete the selected or last dictated text</td>
<td>Delete that</td>
</tr>
</tbody>
</table>
Windows 7

Accessibility and Voice Recognition

**Keyboard keys**

Commands for keyboard keys

The following table shows commands for using Speech Recognition to press keyboard keys

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press any key on the keyboard</td>
<td>Press keyboard key; Press a; Press capital b; Press Shift plus a; Press Ctrl plus a</td>
</tr>
<tr>
<td>Press certain keyboard keys without saying &quot;press&quot; first</td>
<td>Delete; Backspace; Enter; Page Up; Page down; Home; End; Tab</td>
</tr>
</tbody>
</table>

**Controls**

Commands for using common controls

The following table shows commands for using Speech Recognition to perform tasks in Windows.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click any item</td>
<td>Right-click Computer; Right-click Recycle Bin; Right-click file name</td>
</tr>
<tr>
<td>Minimize all windows to show your desktop</td>
<td>Show desktop</td>
</tr>
<tr>
<td>Click something you don't know the name of</td>
<td>Show numbers (Numbers will appear on the screen for every item in the active window. Say an item’s corresponding number to click it.)</td>
</tr>
<tr>
<td>Click a numbered item</td>
<td>15 OK; 7 OK</td>
</tr>
<tr>
<td>Double-click a numbered item</td>
<td>Double-click 15; Double-click 4</td>
</tr>
<tr>
<td>Right-click a numbered item</td>
<td>Right-click 2; Right-click 3</td>
</tr>
</tbody>
</table>

**Windows**

Commands for working with windows

The following table shows commands for using Speech Recognition to work with windows and programs.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a program</td>
<td>Open Paint; Open NotePad; Open program name</td>
</tr>
<tr>
<td>Switch to an open program</td>
<td>Switch to Paint; Switch to WordPad; Switch to program name; Switch application</td>
</tr>
<tr>
<td>Close a program</td>
<td>Close that; Close NotePad; Close Documents</td>
</tr>
<tr>
<td>Minimize</td>
<td>Minimize that; Minimize WordPad; Minimize Documents</td>
</tr>
<tr>
<td>Maximize</td>
<td>Maximize that; Maximize Notepad; Maximize Computer</td>
</tr>
<tr>
<td>Restore</td>
<td>Restore that; Restore Paint; Restore Documents</td>
</tr>
</tbody>
</table>
Accessibility and Voice Recognition

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut that; Cut</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy that; Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete that; Delete</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo that; Scratch that; Undo</td>
</tr>
<tr>
<td>Scroll an exact distance in pages</td>
<td>Scroll down 2 pages; Scroll up 10 pages</td>
</tr>
<tr>
<td>Go to a field in a form or a program</td>
<td>Go to field name; Go to Subject; Go to Address; Go to Cc</td>
</tr>
</tbody>
</table>

Click anywhere on the screen

Commands for clicking anywhere on the screen

The following table shows commands for using Speech Recognition to click anywhere on the screen.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show the mousegrid</td>
<td>Mousegrid</td>
</tr>
<tr>
<td>Move the mouse pointer to the center of any mousegrid square</td>
<td>Number or numbers of the square; 1; 3; 5; 1, 5, 5</td>
</tr>
<tr>
<td>Click any mousegrid square</td>
<td>Click number of the square</td>
</tr>
</tbody>
</table>

Select an item to drag with the mousegrid Number or numbers of the square where the item appears; 2, 5, 7 (followed by) mark

Select an area where you want to drag the item with the mousegrid Number—or numbers—of the square where you want to drag; 2, 3, 9 (followed by) click ▼
6 Connecting to the Network

6.1 View Available Networks
Windows 7 makes it a very simple to view and connect to networks on your laptop. Just click on the network icon in the taskbar. View Available Networks displays all your wireless and wired networking options including Wi-Fi, mobile broadband, dial-up, LAN or corporate VPN. One more click on any of them, and you’re connected. It is an awesome feature for netbooks as the number of steps required to get connected to internet is reduced and you can instantly get going with your web-browsing.

6.2 Domain Join
A domain is a type of computer network commonly found in the workplace. (In geek-speak, it’s a collection of computers that’s centrally administered and operates under common rules.)

Windows 7 Professional and Ultimate come with a handy utility that lets you join domains quickly and securely. Just follow the easy-to-use wizard, which prompts you to enter your network credentials. You will be in business in no time.

6.3 Windows Connect Now
Windows Connect Now makes it easier to set up a wireless network at home or work. Just buy a Wi-Fi router with a "Compatible with Windows 7" logo. The first time you connect, Windows will walk you through all the necessary setup steps—including naming your network and turning on the router’s security features. After that, you need not remember your network credentials when you connect new computers. Just push the Wi-Fi Protected Setup button on your router and it will automatically send the network settings to your computer.
6 Connecting to the Network

6.4 Home sweet homegroup

Homegroup is a new concept introduced in Windows 7 that makes sharing music, photos, videos, files and printers with other people on your home network easy and intuitive. You can now create a password protected home network in very few clicks without going through the hassle of setting up a network and fiddling with network configuration. You can even make your files ‘read only’ so that other people can access your content, but not change it. It's only available in Home Premium, Professional, and Ultimate variants of Windows 7.

If you remember what a headache it was to set up file and printer sharing in earlier versions of Windows, you'll be amazed at the difference a homegroup makes. During the process of setting up or joining a homegroup, you can choose the libraries and printers you want to share, and you are done. Even creating a homegroup is as easy as running a wizard.

6.4.1 Creating and joining a homegroup

To create a homegroup, open HomeGroup in Control Panel and then click on Create a homegroup. Your current network location must be set to “Home network.” That's because HomeGroup only works on networks having the Home network location. If you need to change the network location to Home from Work or Public, just click the current setting, and then pick it.

Computers must be running Windows 7 as a rule to be part of a homegroup (Windows 7 Starter and Windows 7 Home Basic only allows you to join a homegroup, but does not let you create one). If you're installing Windows 7 and you were already on a home network, a homegroup will be set up and joined automatically. You can join a homegroup by opening
HomeGroup in Control Panel and clicking Join now. (You can also get to these options by going to ‘Network and Sharing Center’ and clicking on ‘Choose homegroup and sharing options’)

6.4.2 Accessing files and printers on the Homegroup

To access files and printers shared by other homegroup PCs, open the libraries folder by clicking on your User Name in the Start Menu. Here, under Homegroup in the left pane, click the PC you want to access and then click the library you want.

To easily change homegroup settings such as the libraries you want to share, select the check box for each library you want to share, and then click Save changes. This option is found under Share libraries and printers in HomeGroup (Control Panel)
Connecting to the Network

- To share other libraries that you've created, follow these steps:
- Click the Start button, and then click your user name.
- Select the library you want to share, and then click on ‘Share with’ in the toolbar.

![Sharing your libraries with other users on your homegroup](image)

- Select the people you want to share with
  For printer sharing, and Media streaming, see the corresponding sections in this Fast Track.

6.4.3 Security
As we mentioned, a homegroup is protected by a password. The HomeGroup feature initially provides a password, but you can change it later if you...
want to. People who belong to a home network will not automatically belong to a homegroup and be able to connect to it. They will need a password which appears while you are setting up a HomeGroup before they can join the homegroup or see and access files and printers.

### 6.5 Location Aware Printing

Do you have a habit of routinely connecting printers at different places, say, Home, Work, your Friend’s place, to your laptop? Windows 7 has a handy utility, called 'Location-aware printing' to automatically switch your laptop’s default printer when it detects that you have moved from one network to another and eliminates the need to manually switch printers. Whenever you connect to a printer and print something, Windows 7 associates that printer to the network you were connected to at that time. Next time you connect to that network, Windows 7 automatically switches the default printer to the one it associated with the network. If you have used more than one printer on the same network, then it associates the printer which you set as your
6. Connecting to the Network

6.6 Internet Explorer 8 Compatibility Mode

If your company’s websites is old and hasn't been updated in quite some
Connecting to the Network

6.7 Install a printer on a home network

There are two basic ways to make a printer available to the PCs on your home network:

- Viewing web-pages in Compatibility mode.
- Adding sites to be automatically opened in Compatibility mode.

Time, chances are that it won’t render correctly because of the new rendering engine in IE8. You then need to enable Internet Explorer 8 display them in compatibility view. Now you can do it on the fly but if you visit such sites frequently, then you need to have an alternative to make it the default. Just open Internet Explorer, go to Tools > Compatibility View Settings and check “Display all websites in compatibility view”, then click Ok.
6 Connecting to the Network

- Attach it directly to one computer and share it with all the others on a network.
- Connect the printer as a stand-alone device on the network itself using a network cable.

6.7.1 Setting up a shared printer

Traditionally, the most common way to make a printer available to a home network has been to connect it to one of the PCs and then tell Windows to share it. It will be called a shared printer.

The advantage of sharing a printer is that it works with any USB connected printer. The downside? The host PC always has to be powered up, otherwise the rest of the network won't be able to access the shared printer.

In previous versions of Windows, setting up a shared printer was tricky. But HomeGroup has greatly simplified the whole process.

When a network is set up as a homegroup, printers and media libraries are automatically shared. If you've already set up a homegroup and want to access a shared printer from another homegroup PC, just follow these steps.

Connect to Wizard for connecting to network devices such as a projector connected to your network.
Windows 7

Connecting to the Network

To manually connect to a homegroup printer:
- On the computer the printer is physically connected to, click the Start button, click Control Panel, type homegroup in the search box, and then click HomeGroup.
- Make sure the Printers check box is ticked. (If not, select it, and then click on Save changes.)
- Next go to the computer you intend to print from.
- Open HomeGroup.
- Click on ‘Install printer’.
- If you don’t already have a driver installed for the printer on that computer, click on Install driver in the dialog box that appears after the previous step.

6.7.2 Setting up a network printer

Network printers—devices designed to connect directly to a computer network as a stand-alone device—were once found only in large corporations. No more.

Printer makers are increasingly offering inexpensive inkjet and laser printers that are designed to serve as network printers on home networks. Network printers have one obvious advantage over shared printers: they’re always available.

There are two common types of network printers: wired and wireless.
- Wired printers have an Ethernet port. You can connect it to your router or hub using an Ethernet cable.
- Wireless printers typically connect to your home network using Wi-Fi or Bluetooth.

To install a network, Wi-Fi, or Bluetooth printer:
- Open Devices and Printers.
- Click on ‘Add a printer’.
6.8 Setting up an ad-hoc Network

So, you have multiple laptops, PMP’s and smartphones with Wi-Fi but only one internet connection on your computer? Windows Vista introduced this feature and Windows 7 takes it forward by letting you host an ad-hoc Wi-Fi network in a couple of steps without any difficulty and having to deal with advanced settings.

Before we begin, you should make sure that your wireless card isn’t currently connected and even if your laptop is connected to the wired network, your wireless card should be free, so that you can use it to allow access to the internet by bridging it to the LAN or through internet advanced network sharing properties that Windows 7 provides you with.

- In the Add Printer wizard that pops up, click on ‘Add a network, wireless or Bluetooth printer’.
- A list of available printers comes; select the one you want to use, and then click on Next.
- Complete the subsequent steps in the wizard, and then click on Finish.
connection sharing. To set up, follow these steps:
- Go to Network and Sharing Center present in the Control Panel (You can quickly access it by right-clicking on the network icon in the system tray and clicking on ‘Open Network and Sharing Center’).
- Next Click on ‘Set up a new connection or network’ in the right pane. You’ll be prompted with a wizard that allows you to connect to VPNs, dial-up, or create a new ad hoc wireless network, which is what you are here to

Change your networking settings

Set up a new connection or network
Set up a wireless, broadband, dial-up, ad hoc, or VPN connection; or set up a router or access point.

Connect to a network
Connect or reconnect to a wireless, wired, dial-up, or VPN network connection.

Choose homegroup and sharing options
Access files and printers located on other network computers, or change sharing settings.

Click on set up a new connection or network to get started.

The connection setup wizard
Connecting to the Network

You can use this ad hoc network to share files back and forth between two computers, and share the internet connection.

- Select ‘Set up a wireless ad-hoc (computer to computer) network’ and click on next twice.
- Here you can enter your network name and chose security options for your Network. WEP is extremely easy to crack and some Linux distributions like BackTrack even come with an in built utility to crack WEP encryption. So we recommend you to use WPA2 encryption with a good key. If you want this ad-hoc connection to become permanent, check the ‘Save this Network’ box. However, if you are just creating this network for one instance and don't plan to use it again, leave it unchecked.
- Now your ad hoc network should be up and running and ready to start connecting your devices.

Click on ‘Turn on Internet Connection Sharing’ if you want to provide internet access to other devices that you intend to connect using this network.

You’ll notice that the ad hoc networks that you create get added to the View Available Networks list. When you disconnect from your ad hoc
network, it's the same as stopping it. Connecting to the network is the same as setting and starting it back up; this way you can quickly switch back and forth between connection.

If you are connected to the internet using Local Area Network, then remember to enable Internet connection sharing for your LAN adapter also by going to Network and Sharing Center and click on ‘Change adapter settings’ in the left pane. Then right click on whatever adapter is connected to the internet and enable internet connection sharing for it.

6.9 Stream your Media
Windows 7, makes it easy to play music and video on other networked PCs, TVs, or stereos around the house.

If you have a home network, you can use Windows Media Player in Library mode showing Streaming options.
Connecting to the Network

Player to stream media to computers and media devices spread across your home. Media streaming was called media sharing in earlier versions of Windows Media Player.

The following procedure explains how to get started.

6.9.1 Connect your device or another computer to your network

Before you can stream media, you’ll need to connect your digital media devices or other computers to your home network. Just connect an Ethernet cable from your device or other computer to your wired network, or set up your device or computer to join your wireless network.

6.9.2 Turn on home media streaming

If media sharing isn't already turned on, follow these steps:

- Open Windows Media Player.
- Switch to Library mode
- Click on Stream, and then click on Turn on home media streaming available on the Media streaming options page.
- This option won’t be available on the Stream menu if streaming is already turned on.
- Click on OK.

Notes

- If your computer is on a public network, you will be prompted to change the network location to a Home network before you can stream media.
- If you have set up a homegroup, you will be prompted to share your media libraries with your homegroup (if you haven’t already done it) before you can stream media.
6.9.3 Set up basic streaming preferences

After you turn on media streaming, Windows Media Player will automatically detect any computers and devices on your network that can receive media streams. You can either stream media to all computers and devices on your network, or allow access to your media on a case-by-case basis. To choose which devices will receive your media streams, follow these steps:

Media Sharing options to configure whom to share your media with

After you have turned on media streaming, you get a few more options.
6 Connecting to the Network

- Open Windows Media Player and Switch to Library mode
- Click on Stream, and then open More Streaming Options.
- More streaming options won't appear on the Stream menu if you haven't turned on home media streaming.
- On the Media streaming options page, choose one of the following:
  - If you want to stream media to all computers and devices on your network, click Allow All.
  - If you don't want to stream media to any computers or devices on your network, click Block All.
  - If you want to stream media to some computers and devices, click either Allowed or Blocked on the menu next to each item in the list of computers and devices.
- Press OK and you're done.

6.9.4 Receive a media stream from another computer or device on your network
You can use Windows Media Player to receive a media stream from another computer or media device on your network so that you can play it on your computer. Just follow these steps:
- Open Windows Media Player and Switch to Library Mode
- Click on another computer’s Player Library on your network listed under Other Libraries in the navigation pane on the left.
If you don't see Other Libraries in the navigation pane, then do the following:
• Click on Organize, and then click on Customize Navigation Pane.
• At the top of the Customize Navigation Pane dialog box, click on the name of the Library in the drop-down list, and then click on Other Libraries.
• Select the Show Other Libraries check box, and then press OK.
• Find an item you want to play in the details pane, and double-click it.

6.9.5 Stream media to another computer or device using Play To
You can use Windows Media Player to stream media, or play to, another computer or media device on your network. The only requirement is that your device should support the industry standard DLNA (Digital Living Network Alliance) 1.5 digital media renderer (It also works with other Windows 7 PCs). To play to another computer or device, follow these steps:
• Open Windows Media Player and Switch to Library Mode
• If the list pane is closed or if the Burn or Sync tabs are exposed, click on the Play tab.
• Find the items that you want to play in the Windows Media Player Library, and then drag those items from the details pane into the list pane.
• Click on the Play to button Picture of the Play to button at the top of the list pane
• Click on the device on your network that will receive the media.
• In the Play To dialog box, use the playback controls to play, pause, go to next/previous or to stop the media stream.

When you stream music to a digital media receiver, you will not be able to switch tracks using controls on the device itself or the remote control that came with the device unless it complies to DLNA 1.5 completely.
Backup and Restore

7.1 Backup

The data stored on your computer’s hard-disk is valuable and perhaps irreplaceable. If you have lost files on your computer and you are not familiar with data backup or you just chose not to backup because its too much trouble, this chapter is for you.

If you are one of those lucky people who have never lost a file on your computer: congratulations! However it is still vital for you to understand that encountering problems sometimes is inevitable. It can result from your fault while making a change or a virus or just some power surge leading to hardware failure. That’s why you should regularly backup your files, preferably to an external hard-disk to be prepared for the worst. Windows 7 comes with its own Backup utility, that’s designed to read your data, compress it and store it on the external medium automatically and you can even set a predefined schedule for it.

7.1.1 How is it different from Copy Pasting Data?

Backup and Restore feature has several advantages over simply copying files to a removable disk. This utility compresses your data as its being copied on the fly so that more of it fits into the medium. It even allows you to split large files across multiple disks and in emergency, it offers several data-recovery aids for you to recover files quickly. If you’re using the Professional, Enterprise or Ultimate editions of Windows 7, you’ll also have the option
of backing up your files to a network. In all, its more flexible and easier to manage.

7.1.2 How to use Backup in Windows 7?
Open Backup and Restore by going to Control Panel and selecting "view Small/Large Icons" at the top right corner or from the "System and Security" link in the standard menu. The left pane of Backup and Restore utility has two links to "Create an image backup" and "Create a System Recovery Disc" while the right pane will display different options regarding backup and restoring.

Backup and Restore Window

Choosing what you want to backup
7 Backup and Restore

Windows 7

To back up choose one of the following:
- If you have never used Windows Backup before, click Set up backup, and then follow the steps in the wizard. You basically have to choose what to
backup and where to do it. You can also backup on a location on the network by clicking on the Add Network Location. At last, you have to click on the Save settings and run backup button to start the backup

- If you have created a backup before, you can wait for your regularly
7 Backup and Restore

scheduled backup to occur, or you can manually create a new backup by clicking Back up now. We recommend that you don’t backup your files to the same hard disk that Windows is installed on.

7.2 Restore files from a backup

You can restore backed-up versions of files that are lost, damaged, or changed accidentally. You can also restore individual files and folders that you have backed up.

- Open Backup and Restore.
- To restore your files, click Restore my files.
- To restore the files of all users, click Restore all users’ files.

Click on Restore options to recover your files from the backup

- To browse the contents of the backup, click Browse for files or Browse for folders. To view individual files, use the Browse for files option because when you are browsing for folders, you won’t be able to see the individual files in a folder.
- To search the contents of the backup, click Search, type all or part of a file name, and then click Search.

To restore a backup made on another computer

You can restore files from a backup that was created on another computer running Windows Vista or Windows 7.

- Open Backup and Restore.
- Select the 'Select another backup to restore files from' link, and then follow the steps in the wizard that follows.

7.3 Startup repair

If you’ve downloaded Windows 7, it’s a good idea to create a system repair
disc straight away in case you run into problems booting the OS later on. Open Control Panel -> Backup and Restore -> Create a System Repair Disc, and let Windows 7 build a bootable emergency disc. If the worst does happen for whatever reasons, then it could be the only way to get your PC running again. Startup Repair essentially just scans your computer for the problem and then tries to fix it so your computer can start correctly. Though it can't fix hardware failures, such as a failing hard disk or incompatible memory, Startup Repair does a good job at fixing certain problems, such as missing or damaged system files.

### 7.4 System Image Backup

Windows Backup provides you with the ability to create a system image, which is an exact copy of a drive. By default, a system image includes Windows, drivers required for Windows to run and your system settings, programs, and files. You can use a system image to restore the OS and data of your computer if your hard drive or computer ever stops working.

You must however remember that it will be a complete restoration; you can't choose individual items to restore, and all of your current programs, system settings, and files are replaced. You can manually create a system image if you want to include additional data partitions or drives.

- Click on Create an image backup in the left pane of the Backup and Restore window.
- Select the location you want to store the system image. It can be another partition, a network location or an external disc. Click on Next.
Backup and Restore

Windows 7

Select your dvd drive to start creation of System Repair Disc.

Options to Manage Windows Backup.
Windows 7

- Now click on the Start backup button to start the process of creating a system image.

7.5 Recover lost or deleted files
If you can’t find a file on your computer or you accidentally modified or deleted a file, you can restore it from your backup (if you are using Windows backup) or you can try to restore it from a previous version. Previous versions are copies of your files and folders that Windows 7 automatically saves as part of a restore point. They are sometimes referred to as shadow copies.

7.5.1 To restore a deleted file or folder
- Boot up your Computer.
- Navigate to the folder that used to contain the file or folder, right-click it, and then select ‘Restore previous versions’. If the folder was at the top level of a partition, for example C:\, right-click the partition in ‘Computer’ and then click Restore previous versions. You’ll see a list of all available previous versions of the file or folder. It will also include files saved on a backup (if you are using Windows Backup to back up your files) as well as restore points.
- Double-click the previous version of the folder that contains the file or folder you want to restore. (For example, if a file/folder was deleted today, choose a version of the folder from yesterday. It should contain the file.)
- Click and drag the file or folder that you want to restore to another location on your computer, such as your desktop or another folder. The version of the file or folder will be saved to the location that you selected.

7.5.2 To restore a file or folder to a previous state
- Right-click the file or folder, and then click Restore previous versions.
- Before restoring a previous version of a file or folder, select the previous version, and then click Open to view it to make sure it’s the version you want.

Note

To restore a previous version of a file or folder that’s included in a library, right-click the file or folder in the location where it’s saved, rather than in the library. For example, to restore a previous version of a picture that’s included in the Pictures library but is stored in the My Pictures folder, right-click the My Pictures folder, and then click Restore previous versions.

Note

You can’t open or copy previous versions of files that were created by Windows Backup, but you can restore them.
7 Backup and Restore

To restore a previous version, select the previous version, and then click on Restore.

Warning: The file or folder replaces the current version on your computer, and the replacement can't be undone.

7.6 Restore your computer from a system image backup

7.6.1 To restore using the Recovery Control Panel (recommended)
If your computer is still working and you can access Control Panel, or if you want to restore your system image backup onto a different computer, follow these steps:
- Open Recovery by typing it out in the Start Menu.
- Click on ‘Advanced recovery methods’.
- Click on ‘Use a system image you created earlier to recover your computer’, and then follow the steps in the wizard.

7.6.2 To restore using pre-installed recovery options
If you can’t access Control Panel and you don’t have a Windows installation disc or a system repair disc, use this method to restore your computer.
- Start your computer
- Do one of the following:
  - If your computer has only one operating system installed, hold down the F8 key as your computer restarts.
  - If your computer has more than one operating system installed, use the arrow keys to highlight the operating system that you want to start, and then press F8.
- When the Advanced Boot Options screen appears, use the arrow keys to select Repair your computer, and then press Enter.
- Select the keyboard layout you use, and then click on Next.
- Select a user name, type the password for it, and then click on OK.
- In the System Recovery Options menu, click on System Image Recovery, and then follow the instructions in the wizard that follows.

7.6.3 To restore using a Windows installation disc or a system repair disc
If you can’t access Control Panel, you can restore your computer using a Windows installation disc or a system repair disc.
- Insert the installation disc or system repair disc whatever you may have.

Note
If the Restore button is unavailable, you can’t restore a previous version of the file or folder to its original location. But you still might be able to open it or save it to a different location. Try your luck.
Windows 7

Backup and Restore

- Restart your computer using the computer’s power button.
- You will be prompted with a message saying press any key to start the computer from the installation disc or system repair disc. Just press anything on your keyboard.
  
  If your computer is not configured to start from a CD or DVD, change your computer’s BIOS settings.
- Choose your language settings (which is English-India for most of us), and then click on Next.
- Click on ‘Repair your computer’.
  
  This step is only necessary if you are using a Windows installation disc.
- Select a recovery option in the list that comes, and then click on Next.
Customising the Look and Feel

8.1 Calibrate your Display

If you have recently bought a LED-backlit display laptop or if you are using an old CRT, chances are that the default Windows colour, brightness and contrast settings are not accurate and make your favorite photographs and movies look different and most times, just plain bad. The colours you see on your screen varies widely depending on your monitor, graphics cards settings, lighting and more, yet most people use the same default Windows colour profile.

Fortunately Windows 7 provides a Display Colour Calibration Wizard that helps you ensure that colours are represented accurately on your screen and everything looks crisp and sharp.

Click Start (Press Win Key) and type dccw in the "Search programs and files" box to start the Display Colour Calibration Wizard. Alternatively you
can go to Control Panel > All Control Panel Items > Display and click on "Calibrate Colour" from the left pane of the window.

8.2 Display Empty Removable Drives
Windows 7 does not show empty drives by default. Click Computer in Windows 7 and you might see a strange lack of drives, but don't panic, and don't go returning your newly bought drive thinking its broke. It's just Microsoft trying to be helpful: drives like memory card readers are no longer displayed if they're empty. This does seem like an improvement but it should not be a default setting as it makes things harder to figure out for inexperienced users who are used to see everything right there. To get them back, just Launch explorer. Go to Tools > Folder Options > View and uncheck “Hide empty drives in the computer folder”.

8.3 Recover screen space
The new Windows 7 taskbar takes up a lot of screen real estate with its big icons, which isn't a concern but if you are running it on a smallish screen like those of net-books, you can do with recovering some space for applications.

Shrink it to a more manageable size by right-clicking the Start button, then go to Properties > Taskbar > Use small icons > OK.

8.4 Restore the Quick Launch Toolbar
A lot of Windows Vista and XP users will find the absence of a Quick Launch toolbar in Windows 7 annoying because you sort of get used to it. It is disabled by default but it only takes a moment to restore it back.

- Open the "Run" dialog box by pressing [Win] + [R] and type gedit.msc
- On the left hand pane, Navigate to User Configuration, Administrative Templates, and Start Menu and Taskbar
- Double-click on the "Show QuickLaunch on Taskbar" in the right pane. Select Enable, Click on Apply and then press Ok.
- Right click on Taskbar select Toolbar > New toolbar
- Navigate to C:\Users\(user name)\AppData\Roaming\Microsoft\Internet Explorer
- Select the Folder "Quick Launch" and click on "Select Folder".

Now You should see Quick Launch Toolbar on Taskbar. To make it look like it would in Windows Vista, right click the taskbar, uncheck “Lock the Taskbar”, and you should see the Quick Launch toolbar, probably to the right. Right-click its divider, clear Show Text and Show Title to minimize the
Customising the Look and Feel

Enabling Quick Launch from the Group Policy Editor

Select the Quick Launch Folder to Restore Quick Launch in your taskbar

XP style quick launch in Windows 7
space it takes up. For the true retro look, you can also right-click the bar and select View > Small Icons.

8.5 Desktop slideshow

Windows 7 lets you set up a slideshow of multiple images as the desktop wallpaper by default without you grappling with other Desktop Enhancement tools. Some Windows themes include a slide show, or you can create your own slide show from your personal collection of pictures. Right-click an empty part of the desktop, select Personalize > Desktop Background, then hold down Ctrl as you click on the images you like. Choose how often you’d like the images to be changed from the drop down box (anything from daily to once every 10 seconds). You can also select Shuffle if you’d like the backgrounds to appear in a random order. Click on Save Changes and you shall be able to enjoy the show on your desktop.

8.6 Auto arrange your desktop

If the icons on your Windows 7 desktop are scattered everywhere then you could right-click anywhere and select View > Auto arrange, just as in Vista. But a simpler solution is just to press and hold down F5 for a little longer, and Windows will automatically arrange its icons for you.
Virtual Windows XP Mode

If you need to access programs designed for Windows XP that have not been upgraded to Windows Vista or 7, XP Mode creates a virtual environment within Windows 7. It is similar to MED-V, Microsoft’s virtualization technology aimed at large corporations. It consists of Windows Virtual PC 7.0, a new version of Microsoft’s client-based virtualization product line, and a fully licensed install of Windows XP with Service Pack 3 (SP3) and using it couldn’t be simpler. You can use Windows XP mode to access a virtualized instance of Windows XP that can be customized with your own applications. You can also use Windows XP mode with Windows 7 to run applications seamlessly in Windows 7 when the applications are actually installed in Windows XP. It also includes support for USB devices and is based on a new core that includes multi-threading support. However, Windows XP mode is available free only for the 32-bit and 64-bit editions of Windows 7 Professional, Windows 7 Enterprise, and Windows 7 Ultimate and not Home variants.

9.1 Before you begin
To install Windows XP you first need to download and install an update from the Windows XP Mode website or the Virtual PC website which contains the Microsoft Virtual PC application. Also, you need to ensure that your computer either runs the Windows 7 Professional or Ultimate as Windows XP mode is not supported on Home variants. Hardware wise, you must have virtualization enabled (Intel VT or AMD-V technologies must be available for your processor and enabled from the BIOS.)

9.2 Set up Windows XP mode
This section describes how to install Windows Virtual PC and set up the Windows XP mode.
9.2.1 Install Windows Virtual PC
To install Windows Virtual PC follow these steps:
Install the update package:
1. Open Windows6.1-KBxxxxxx-platform.msu, where platform is either x86 or x64 and xxxxxx depends on whether you are installing XP mode beta or RC or the final release. (This file is available from http://www.microsoft.com/windows/virtual-pc/download.aspx)
2. Review its end-user license agreement and accept it to install the update.
3. To complete the installation, you will have to restart the computer.
4. After it is finished, Windows Virtual PC is available in the Start menu.

After you install Windows Virtual PC, you need to set up Virtual Windows XP.

9.2.2 Set up Windows XP mode
If you want to use Windows XP as a guest operating system, you will have to use the Virtual Windows XP downloadable package available from the same website. When you use this package with Windows Virtual PC, it automatically creates a virtual machine for it with a version of Windows XP installed on the virtual hard disk.

To set up Windows XP mode:
1. Double-click VirtualWindowsXP.msi
2. The Virtual Windows XP wizard will open. Proceed through the steps of the wizard to complete the installation.
3. When the virtual machine is booted up or started for the first time, the Virtual Windows XP license agreement appears. To use Virtual Windows XP, you must obviously accept it. Then click on Next to continue.
4. Set up a password for the “User” account. This is the account with administrator privileges that the wizard creates automatically. It is also the default account used to run Windows XP mode. Make sure you check “Remember credentials” if you don’t want to enter the password each time you start Windows XP mode.
5. After Windows Virtual PC configures Virtual Windows XP, the virtual machine will be ready to be used.
9.2.3 About integration components
Integration components make it easier to use a virtual machine by improving the interaction between physical resources and a virtual machine environment. These are installed automatically when you set up Windows XP mode on your computer. Integration components provide access to the following resources:

- Clipboard. You can cut, copy, and paste data between the host operating system and Virtual Windows XP. For Windows XP working in Windows 7.
example, you can copy a URL from the browser in a XP, and paste it to a browser in Windows 7.

• Hard drives. This feature makes all the drive partitions on the host available to the virtual machine. You can easily access all host data from within the virtual machine.

• Printers. This feature makes it possible for you to use the same printer in a virtual machine that you can use on the host.

• USB devices. Printers and storage devices are automatically shared with virtual machines. Other types of supported USB devices can be shared by redirecting them to the virtual machine.

Integration components also allows you to move the mouse seamlessly between the desktops of the host operating system and the guest operating system.

Note
Host hard drives are listed in the guest by using the computer name of the host operating system. For example, on a host computer named huh, the C drive would be listed in the guest operating system as 'C on huh'.
9.2.4 Closing a virtual machine

When you close a virtual machine, it can be hibernated, shut down, or turned off. When a virtual machine is started from hibernation, it does not go through the boot sequence, so it is available for use faster than if it was turned off or shut down.

By default, clicking the Close button (the ‘x’) on the virtual machine window hibernates a virtual machine. You can also change this behavior by modifying the virtual machine settings.

To change the default close option, choose one of the following:
• In the Virtual Machines folder, right-click the name of the virtual machine, and then click Settings.

**Note**

When you open a virtual machine, Windows Virtual PC provides it with memory and processor resources. The length of time it takes to open a virtual machine also depends on the amount of memory assigned to the virtual machine which you can change by opening settings in Windows Virtual PC for your XP when it is not powered on.
9.3 Use a virtual machine application on Windows 7

You can access an application directly from the desktop of the host operating system when the application is installed in the virtual machine. So now you can use Windows XP applications while avoiding problems that occur because they are not compatible with your Windows 7.

However, Windows Virtual PC does not support applications that require bidirectional sound or 3D graphics, which means that games cannot be played in Windows XP mode.

To share a virtual machine application with Windows 7

1. Open the virtual machine, if it is not already running by going to the Virtual Machine folder and right-clicking on the name of the virtual machine and selecting Open.

2. Install the application.
3. After the installation completes, log off from the guest OS and close the virtual machine.

4. Open the application from the host OS by going to Windows 7 Start menu, clicking on All Programs, then on Windows Virtual PC and finally clicking on the name of the application, below the name of the virtual machine.

5. After a few seconds, the application will open. If you minimize the application, it will appear on the task bar of the host operating system as a minimized virtual machine.

6. You can use the application just as if it were installed directly on Windows 7.

9.4 Use a USB device in a virtual machine

Windows Virtual PC supports the use of USB 2.0 devices, either by sharing the device or by redirecting the device to the virtual machine. The method you use will depend on which type of USB device you intend to use. When integration components are installed in the Virtual Windows XP, storage devices are automatically shared with virtual machines on a physical computer. For other types of devices like WebCams, Wireless network adapters, PDA’s and mp3 players, you can use redirection.

To redirect a USB device to a virtual machine:

- Attach the device to the computer and turn on the device.
• From the virtual machine window, click on USB and then click on Attach '<device name>'.
• After the device driver is installed, you can use the USB device from within the virtual machine the same way as you would on a physical computer. However, USB devices that are connected using these steps cannot be shared, so they must be released from one operating system to be available for use on the other operating system.
• To make the USB device available back on your host Windows 7 installation, release it from the virtual machine. From the virtual machine window, click on USB and then click on 'Release <device name>'.

Sharing USB devices with your virtual machine